KCodes 9 Series Print Server

User’s Manual

Chapter 1 Introduction

Thank you for purchasing 901n/901i Print Server (in the following referred to as “Server”). This Server is
designed to connect your Printer, Multifunction Printer, iPhone, iPod to your network, allowing all network
users’ access to these shared USB devices.

1.1 About 2 Models Described in this Manual

This manual provides introductory information as well as detailed instructions on how to set up and
manage 9 Series in various network environments. The following table shows the differences among the
2 models. All 2 models have one USB port, a 10/100 Mbit/sec Lan port and an additional wireless module
(802.11b/g/n). However, 901n is external antenna while 901i is internal antenna. Except for the antenna
type, most configuration and operations are the same for 901n and 901i. Unless explicitly specified, all
instructions in the manual apply to 9 Series.

Model Name LAN Wireless Antenna USB Port(s)
901n Yes Yes external 1
901i Yes Yes internal 1

To fully benefit from this document, you should be familiar with basic networking principles. The
instructions described in this manual are based on the settings in a new Server. To reload the Factory
Parameters, you can reset this Server back to Factory Default, which will restore most of the settings. For
details, please refer to the chapter “Restore Factory Defaults”.

1.2 Customer Support

Should you require any technical assistance, please contact your product reseller. Or you can visit our
website for latest product information. This document is subject to changes without prior notice.
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Chapter 2 Product Overview

2.1 Package Contents

Verify that nothing is missing from the package by using the checking list below. Please contact your
dealer if anything is missing or damaged. All packing materials are recyclable. Please confirm the items in
the package below:

v' This Server (901n/901i)

v' CD (Control Center and User’s Manual and Quick Installation Guide)

v' Power Adaptor(5V1A)

2.2 Product CD

This CD provides easy-to-use Control Center software, and the User’s Manual and Quick Installation
Guide.

2.2.1. Start-up Procedures

If your computer is configured to auto start CDs, this CD will start automatically when inserted. You can
also navigate to the CD and start the autorun.exe file from within the Windows file manager.

2.3 Physical Description

1. Power Adaptor Connector : 5V/1A
Init Button : for restoring the configurable parameters to the default values
3. Wireless Station : IEEE 802.11 b/g/n wireless station with external antenna for 901n or internal
antenna for 901i
. Ethernet Connector : connected to a twisted pair category 5 cable
5. USB Host Ports: USB 1.1/2.0 low, full, and Hi-Speed compliant
6. Indicators
. Power Indicator is lit while power is applied. If it is not lit, or if it blinks, there is a problem with the
Print server or Power Adapter.
° WLAN Indicator blinks whether user connects wireless or not.
° LAN Indicator blinks to indicate wired network activity. If it is lit, it indicates the wired network is
applied. If it is not lit, it indicates that the server does not connect to the wired network.
° USB Indicator is lit while a USB device connects to a USB Port of the USB device server. If it is not lit,
or if it blinks, there is a problem with the USB device or the USB device server.
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2.4 Supported USB Devices

The USB device server supports the following types of USB devices.
v' USB Printer

USB multifunction printer (MFP/AIO)

iPad

iPhone

KX
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Chapter 3 Basic Installation

3.1. Connecting the Hardware

1. Make sure that your USB devices are switched off and that the Server’s Power Adapter is
disconnected.

Connect the USB devices to the USB ports with the USB cables.

Connect the Server to the network with a twisted-pair category 5 cable, 10baseT or 100baseTX.
Turn on the USB devices and make sure it is ready for use.

Connect the Power Adapter to the Server. The POWER indicator, WLAN indicator, LAN indicator,
USB indicator will light up. When the LAN indicator lights up, the Server is correctly connected to
the network. When WLAN and USB indicators stop litting, the Server starts to work normally.

vk W

3.2. Preliminary

v' Before you can access wireless network, wireless parameters should be set correctly. You
have to setup the first wireless parameter set through LAN (wired) connection or connect to
server directly.

v' Wireless access can be set as infrastructure (station) mode, which need an access point to
route network messages with the same SSID.

v' Wireless access can be secured by WEP (64/128), WPA-PSA (TKIP/AES), and WPA2-PSK (AES).

v"Ininfrastructure mode, the maximal transfer rate is 150 MBits depending on access point’s
capability.

3.2.1. Set Wireless Configuration Using Control Center

1. Install USB Device Server Control Center. It is available in the 901n/901i Print Server Product CD.
2. Start USB Device Server Control Center and Auto-searching USB Device server window will appear.

UDSEIPD
K

ma RBEFit




3. If the tool finds servers in your local area network, then you have to select a server from the
server list.

4. Double click the highlighted server (or click the “Configure Server” button) to get the server’s web
pages. Then login with administrator ID (default: admin) and its password (default: admin).
Authentication Required

The server hitp://192.168.1.5:80 requires a username and
password. The server says: "myPrintC1.

User Mame: admin

iiiiﬂ

Password:

LogIn Cancel

5. Click Connect to Another AP and choose one of existing wireless networks.
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6. Click select to choose your AP and enter the AP’s password. Please wait 60 seconds to allow
device reboot.

| Return to Homepage |

[ sso | Seleet
—

Sucé. Phone | Select |

KCODES?2

KCODES3 | Select |

| KC_HW 24G ” ‘
[ mean |[sea)
| = [Lselect |

WesternDigital || ‘
KCODES2_RPT ” ‘

| Return fo Homepage |

Kev | |

| <<Back | | Connect |

7. You have now finished the procedure of setting the wireless parameters.
After properly configuring the wireless parameters, you can remove the network cable and reboot the
server. 901n/901i will then connect to your wireless network. Or you can connect the server directly as

below.

1. Setup PC wireless to connect the server. (Default SSID: myPrintXX)
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2. Thenyou can enter the server’s web pages through using control center or entering the server’ IP
on the web browser.(Default: 192.168.1.100)

3. Soyou can Connect another AP on the web page as 3.2.1

901n/901i will detect if a network cable is plugged-in or not. If a network cable is plugged-in, 901n/901i
will always connect to the network through the network cable. Otherwise it will always connect to the
network through wireless module.

Once 901n/901i connects to the network, either by network cable or by wireless module, all operations
to use USB device server are exactly the same.
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3.3. Assigning an IP Address to the Server

3.3.1. Preliminary

v"If you have a DHCP server on your network, your Server will receive an IP address
automatically. The IP address will then appear on the Control Center or on the page of
configuration report that you printed earlier. If your DHCP server does not give an IP address
to the Server, the Server will use the automatic private IP addressing IP: 169.254.0.0. ~
169.254.255.255

v' If you are not working in a DHCP network, you need to manually set the Server’s IP address.

3.3.2. IP Address

Unless you are assigning an IP address using DHCP, you must obtain an unused IP address
from your network administrator.

3.3.3. Methods for Setting the IP Address

You can set the IP address of your Server using one of the following methods, depending on your network
operating environment:

v' Automatic IP Address Assignment

v' Manual IP Address Assighment

3.3.4. Server Names and Server Name Rules

The default Server name of the Server is “myPrintXX”. Every server has different server name.

3.3.5. Setting the IP Address Using DHCP

Follow the instructions below to get an IP address using DHCP:
1. Edit or create a scope in the DHCP manager of the DHCP daemon. The entries included in this scope
should contain the following parameters:
v" range of IP addresses
subnet mask
default router IP address
DNS server IP address
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lease duration
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2. Activate the scope. The Server automatically gets the DHCP parameters. If you are using DNS, you
may include at least one DNS server IP address in the DHCP scope or manually set the DNS server IP
address using Server’s web pages or the Control Center.

3.3.6. Setting the IP Address Using the Control Center

Install the Control Center. The Control Center is available on the Product CD.
Start the Control Center and Auto-searching Server window will appear.
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3. If the tool finds multiple Servers in your local area network, then you have to select one Server from

the Server List.

4. Double click the highlighted server (or click the “Configure Server” button) to get the server’s web
pages. Then login with administrator ID (default: admin) and its password (default: admin).
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Authentication Required

The server http://192.168.1.5:30 requires a username and
password. The server says: "myPrintC1.

User Mame: admin

Password: | ***** |

Log In Cancel

5. Setup IP Address, Default Gateway and DNS IP. Default Gateway and IP Address should be the same
subnet. Then click the update button.

Current IP: 192.168.1.5
DHCP #| Disable
IP Address: 192.168.200.19
Subnet Mask: 255 255 2550
Default Gateway: 192 168.200.19
DNS Disable
DINS IP: 8.8.8.8
Update

6. Click the button corresponding to your choice of IP setting methods (static or dynamic using DHCP).
When assigning a static IP address you also have to define Subnet Mask.

7.  Click Submit to save your settings. And the Server will reboot. You have now finished the procedure
of setting the IP address.

Chapter 4 Using the Print Server

4.1. Introduction

The goal of this produce is to provide the print server in a single product. We developed new technology
called “NetUSB” and “AirPrint” to achieve this goal. Basically, the “NetUSB” is a “USB over IP” technology
that transparently redirects all USB packets to TCP/IP network channel. “NetUSB” allows you to use print
devices as if they were connected directly to your PC although they are actually remotely connected to
the 901n/901i USB device server. And “AirPrint” is a technology that allow you to print photos or
documents on your iPhone or iPad without any cable.
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4.2. NetUSB funtion

4.2.1. Connect & Disconnect

“NetUSB” allows you to use USB devices as if they were connected directly to your PC although they are
actually remotely connected to the 901n/901i print server. The “connect” operation is a software
operation that simulates an actual USB device plug-in. That is to say, when you do a “connect” operation
in the Control Center, PC can then detect a print device’s plug-in, although actually you do not plug in any
USB device. Similarly, the “disconnect” operation is a software operation that simulates the
disconnection of the USB device. Once the connect operation is successful, the operations to use that
USB device are just the same as if the USB device is directly connected to the PC.

If a USB device is “connected” by a PC, we say that PC has the ownership of the print device. Only one PC
can get the ownership of a USB device at the same time. Therefore, if a USB device is connected by one
PC, no other PC can connect this USB device until this USB device is disconnected.

4.2.2. Subnet Issue

Before using the NetUSB technology, you must first make sure that your PC can access USB device server
via TCP/IP. The simplest way to do this is using “Control Center” to search for the USB device server on
the network and change its IP address to be the same subnet as your PC. If the server and your PC are not
in the same TCP/IP subnet, Control Center will show the server in red, as the following figure. You must
change the IP address (or using DHCP) of the server so that the server and your PC are in the same subnet.
Control Center will show these servers in blue, meaning you can access these servers by the NetUSB
technology.
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4.2.3. Installation of USB Device Driver

Some USB devices, like printers or MFPs (multifunction printers), require to install vendor-supplied driver
(usually on CDROM). For those USB devices that do not need to install driver, please skip this section.
1. Insert the CDROM into the CD drive and run the “autorun” program.
Follow the instructions of the installation program to install driver.
When the installation program asks you to plug-in the USB device, run the “Control Center”.
In the Control Center, click the USB device server that has the desired USB device attached.
Click the desired USB device as the following figure.

ik W NN

6. Click the “Connect” button. Then the message “Manually Connect by your_computer_name” will
be shown, as the following figure.
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7. Now, the installation program will detect the USB device and continue to install driver.
8. After the installation is completed, click the USB device in the Control Center and then click the
“Disconnect” button to disconnect the USB device.

Now the driver of your USB device is installed.

4.2.4. Using the USB Device Server

1. Inthe Control Center, click the USB device server that has the desired USB device attached.
2. Click the desired USB device.
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3. Click the “Connect” button. Then the message “Manually Connect by your_computer_name” will
be shown.

Network
Scanner

4. Now, PC will detect the plug-in of the USB device. The “connect” operation is a software operation
that simulates an actual USB device plug-in. That is to say, when you do a “connect” operation in
the Control Center, PC can then detect a USB device’s plug-in, although actually you do not plug in
any USB device.

5. Then, just use the USB device as if it is connected directly to your PC’s USB port.

6. After you finish using the USB device, click the USB device in the Control Center and then click the
“Disconnect” button to disconnect the USB device. Other PCs can not “Connect” the USB device
until you “Disconnect” that USB device. That is to say, only one PC is allowed to connect the USB
device at the same time.

Network
Scanner
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4.2.5. Auto-Connect Printer

The method described in section 4.2.4 is so-called manual-connect, which means users must manually
connect the USB device before using that device, and must manually disconnect the USB device after
using the device, otherwise nobody else can connect this device. However, for printers and scanners (and
MFPs), the USB device server supports auto-connect so users don’t need to manually connect/disconnect.
This and the next sections show you how to do this.
After the driver is installed as described in section 4.2.3, you can see a newly created printer in the
Control Panel’s “Printers and Faxes”. Follow the steps below to do a NetUSB auto-connect printing.

1. Inthe Control Center, click the USB device server that has the desired printer (or MFP) attached.

2. Click the desired printer (or MFP).

3. Click the “Auto Connect Printer” button and choose “Set Auto-Connect Printer”.

The following figure will appear.
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< Installed Printer List »

Frinter M ame

E& Canon MP430 senes [Esa= s

Choose the desired printer. The desired printer must be the Windows printer (this is a logical
printer) that matches the printer attached on the USB device server (this is a physical printer).
Then click the “Apply” button.

Then, the printer will be marked as an “Auto-Connected Printer” in red. If you choose “Auto-
Connected Printer List” in the “Tools” menu, you can see a newly created item that describes the
association between the Windows printer and the physical printer on the server.
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Server [P & Printer Name Windows Printer Mame

192.168.200.101 - Canon MP4930 zeries Cahon MP430 series

6. Then try toissue a print job to the desired printer. You will see the Control Center will
automatically do a connect operation. Then, the print job will be issued to that printer.

7. Evenyou already properly setup an auto-connected printer, the Control Center must be running
(in the background) while a print job is issued. This means you’d better run the Control Center
every time after you login Windows. In order to skip this manual operation, you can make the
Control Center be run automatically after you login Windows. To do this, choose the
“Configuration” item in the “Tools” menu. The following window will appear. Click on the check
box and then on the “OK” button. This feature is enabled by default.

—Bazic

Automatically execute when logging on 'Windows

—Language

E nglizh
Deutzch

ERE

Mate: Language setting will take effect an nest execution.

If you would like to break the association between the Windows printer and the physical printer, just click
on the association and click the “Delete” button in the “Auto-Connected Printer List”.
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4.2.6. Request to Connect

If a USB device is manually connected by any other user, basically you can not connect that device.
However, we offer another mechanism called “Request to Connect” to solve this inconvenience. For
example, there are two computers — TESTES and TEST. Now the owner of “HP Photosmart 2600” is TEST.
Then, the TESTES computer wants to use this HP printer. The user on the TESTES computer can click the
“Request to Connect” button in the Control Center. The following window appears.

At this moment, the user on the TEST computer will see the following window, indicating that another
computer — TESTES is requesting to use the HP printer.

The user will choose to accept or reject. If accepted, the Control Center on TEST will automatically
disconnect the device and the Control Center on TESTES will automatically connect that device.
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4.2.7. Quitting the Control Center

The Control Center doesn’t really quit if you click the “X” box (close box) at the top right corner of the
window. Instead, it just minimizes itself to the system tray. There are two ways to really close the Control
Center. The first way is choosing “Exit” item in the “File” menu in the Control Center. The second way is
right-clicking the icon of the Control Center in the system tray and choosing the “Exit” item

4.2.8. Limitations

There are some limitations to use the NetUSB technology.

1. Only supports Windows XP/2003/Vista/7/8. Windows 98/ME is not supported.
2.  Supports Mac OS X 10.6 Snow Leopard/10.7 Lion/10.8 Mountain Lion/10.9 Mavericks.
3.  Only one PC can get the ownership of the same USB device at the same time.

4.3. Airprint Function

“Airprint” allows you to use USB devices directly by your iPhone or iPad though they are actually remotely
connected to the 901n/901i print server.

4.3.1. Using Airprint

1. Open iPhone setting and setup the wifi to connect the server.

2. Choose one of pictures or documents you want to print, click and print.

© 2014 KCodes Corporation. All rights reserved. 6 Series v2 User’s Manual V1.0



3. Then you can select printer.

4. After you select the printer you can print anything you want.
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Chapter 5 The Server’ s Web Pages

5.1. Introduction

The Server runs the http server, http on TCP port: 80. Users may use the web pages to see the Server’s
system status and configure the Server.

5.2. Using the Server’ s Web Pages

5.2.1. Displaying Server Status

When you open the server’s web pages (the system will request user to enter administrator (default:
admin) and password (default: admin) to login.), you can see all the status of the server.
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5.2.2. Setting up Server Configuration

You can also set up the Server configuration here..

v' General Configuration
) Server Information: You have to set the SSID and Password, which is the name to represent the

Server.

° TCP/IP: You have to set the Server’ s TCP/IP configuration to connect TCP/IP network. Please see

Chapter 3 Basic Installation for more details.

Current IP: 192.168.1.5
DHCFP Dizable
IP Address: 172.1.1.1
Subnet Mask: 255 I55 2550
Default Gateway:  [172.1.1.254
DNS Dizable
DNSIP:

Update

. Maintenance If you want to restore factory default values of the Server or upgrade new
firmware, you can use the Maintenance tool.
M Reset Settings to Default : click this button, the Server will restore factory default

values.
M Upgrade Firmware: click Choose file to find the firmware file to be upgraded.
Click Upgrade Firmware to upload the firmware into the Server.
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Chapter 6 Troubleshooting

This chapter provides useful information to help you resolve difficulties that you may experience with your
Server. Fault symptoms, possible causes, and remedial actions are provided within a quick reference table.
This Server’s USB ports only support MFPs, printers.

6.1. LED Indicators

Indicators | Behavior Description
POWER Oon Power On
Off Power off/System error
WLAN Blinking Activity on wireless
LAN Blinking Activity on network
Off No activity on network
USB On USB device connected
Ooff No physical connection to USB device

6.2. Firewall

If a firewall software has been installed on your PC, it may block the communication between the PC and
the USB device server so that the USB device server can not work properly. To solve this problem, either
disable the firewall or configure the firewall to allow the following TCP and UDP ports:

7303, 7305, 7411, 20005
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Chapter 7 Restore Factory Defaults

You may restore the Server’s default parameters by one of the following methods.

7.1. Using the Server’ s Web Pages

Go to the Server’s web page and click Reset Setting to Default

Firmware Version +1.01

Cheoose File | Mo file chosen

| Upgrade Firmware |

| Reset Settings to Default |

1. Click Yes to confirm
2.  Wait for 60 seconds

7.2. Using Init Button

Turn on server and wait until you can see it on control center, press the initial button over 10 sec. Server’s
WLAN and USB LED indicators will automatically blink and restart, this process will take about 1 min, after
restart server will back to factory default.

7.3. Default Parameters List

v' General Information
o Server Name: myPrintXX
v’ TCP/IP
. Automatically get IP by DHCP: Enabled
. Static IP: Disabled
o - IP Address: 192.168.1.100
. - Subnet Mask: 255.255.255.0
v' User Accounts
. Administrator: admin

o Password: admin
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Chapter 8 Upgrade Firmware

This chapter describes how to upgrade firmware. Please follow the following Procedures:

8.1. Using the Control Center

1. Open Control Center. It will automatically search the existing Servers and display their statuses.
Select the Server that you want to upgrade the firmware. Double click the selected Server to get the
serve’s main web page.

3. Login the Server with Administrator (default: admin) and Password (default: admin).

Click Choose File to choose the file of new firmware.

5. Click Upgrade Firmware to start firmware upgrade.

Firmware Version v1.01

Cheoose File | Mo file chosen
| ivinkeestevimseritelferetinttl|

| Upgrade Firmware |

| Reset Settings to Default |

6. Wait for 20 seconds for system reboot.

© 2014 KCodes Corporation. All rights reserved. 6 Series v2 User’s Manual V1.0



Chapter 9 The Init Button

The Init button is used for maintenance: Simultaneously press Init button and turn on (by plugging in the
power adaptor) the Server until WLAN and USB LED indicators simultaneously blink. After that, the Server
will do the following tasks:

v' Perform a Factory Default restoration of the server, which will restore most of the
parameters and settings to factory default values.
v' Perform a TFTP server. You can upgrade new firmware using any TFTP client tool.

Note: After performing the tasks mentioned above, you have to plug off the power adaptor and then plug
in the power adaptor to restart the Server.
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Federal Communication Commission Interference Statement

This equipment has been tested and found to comply with the limits for a Class B digital device,

pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection

against harmful interference in a residential installation. This equipment generates, uses and can

radiate radio frequency energy and, if not installed and used in accordance with the instructions, may

cause harmful interference to radio communications. However, there is no guarantee that interference

will not occur in a particular installation. If this equipment does cause harmful interference to radio or

television reception, which can be determined by turning the equipment off and on, the user is

encouraged to try to correct the interference by one of the following measures:

e Reorient or relocate the receiving antenna.

e Increase the separation between the equipment and receiver.

e Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.

e Consult the dealer or an experienced radio/TV technician for help.

FCC Caution: Any changes or modifications not expressly approved by the party responsible for
compliance could void the user’s authority to operate this equipment.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two
conditions: (1) This device may not cause harmful interference, and (2) this device must accept any
interference received, including interference that may cause undesired operation.

For product available in the USA/Canada market, only channel 1~11 can be operated. Selection of
other channels is not possible.

This device and it's antennas(s) must not be co-located or operating in conjunction with any other
antenna or transmitter except in accordance with FCC multi-transmitter product procedures.

For MPE Statement — Mobile device

IMPORTANT NOTE:

FCC Radiation Exposure Statement:

This equipment complies with FCC radiation exposure limits set forth for an uncontrolled
environment. This equipment should be installed and operated with minimum distance 20cm between
the radiator & your body.
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IC

This device complies with Industry Canada license-exempt RSS standard(s). Operation is subject to
the following two conditions: (1) this device may not cause interference, and (2) this device must
accept any interference, including interference that may cause undesired operation of the device.

Le présent appareil est conforme aux CNR d'Industrie Canada applicables aux appareils radio exempts de licence.
L'exploitation est autorisée aux deux conditions suivantes : (1) I'appareil ne doit pas produire de brouillage, et (2)
I'utilisateur de I'appareil doit accepter tout brouillage radioélectrique subi, méme si le brouillage est susceptible d'en
compromettre le fonctionnement.

For product available in the USA/Canada market, only channel 1~11 can be operated. Selection of
other channels is not possible.

Pour les produits disponibles aux Etats-Unis / Canada du marché, seul le canal 1 & 11 peuvent étre exploités. Sélection
d'autres canaux n'est pas possible.

This device and it's antennas(s) must not be co-located or operating in conjunction with any other
antenna or transmitter except in accordance with IC multi-transmitter product procedures.

Cet appareil et son antenne (s) ne doit pas étre co-localisés ou fonctionnement en association avec une autre antenne ou
transmetteur.

IMPORTANT NOTE:

IC Radiation Exposure Statement:

This equipment complies with IC RSS-102 radiation exposure limits set forth for an uncontrolled
environment. This equipment should be installed and operated with minimum distance 20cm between
the radiator & your body.

Cet équipement est conforme aux limites d'exposition aux rayonnements 1C établies pour un environnement non controlé.
Cet équipement doit étre installé et utilisé avec un minimum de 20 cm de distance entre la source de rayonnement et votre
corps.
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